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Getting Started
Congratulations on choosing a Heinle book. iLrn: Heinle Learning Center not 
only saves grading time, but also gives you access to a wealth of data about 
your students’ performance, thereby allowing you to teach more effectively. 
Moreover, students enjoy iLrn: Heinle Learning Center because it is fun to 
use and gives them instant feedback when they complete an exercise. iLrn: 
Heinle Learning Center requires very little setup before you can begin using 
it with students. You’ll need to enter some information about your course and 
its sections, which you’ll do in the Instructor Workstation.

System Requirements

Microsoft® Windows 98, NT, 2000, ME, XP
Browsers: Internet Explorer 6.x or higher, or Firefox 1.x or higher

Macintosh OS X
Browsers: Firefox 1.x or higher, or Safari

Additional Requirements
4	A high-speed connection with throughput of 256 Kbps or more is  

recommended to use audio and video components.

4	Screen resolution: 1024 x 768 or higher

4	CPU: 233MHz

4	RAM: 128MB 

4	Flash Player 7 or higher

4	You will need speakers or a headset to listen to audio and video  
components, and a microphone is necessary for recording activities.
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Setting Up Your Instructor Workstation
When you login to iLrn: Heinle Learning Center, you enter the instructor  
workstation—a central place where you can:

4	View and change your class roster

4	Assign activities and set due dates

4	View and grade your students’ responses

4	Send feedback to your students

4	Customize your book

4	Create your own activities

4	Create and edit your announcement board

4	Send email to your students

4	View your eBook

To begin, you will need to:

4	Create an account

4	Create a course (using an instructor book key provided by Heinle)

4	Create one or more classes

Create a new account:

1. Go to http://ilrn.heinle.com/

2. Click the Login button.

3. Click Create a new account.

5. Fill out the form and click Submit. Be sure to select the correct time zone. 
It’s also important to enter a valid email address so that we can send you 
your password if you ever forget it.

6. Remember to write down your username and password.

Note: If you already have an iLrn: Heinle Learning Center account, you do not need 
to create a new one.
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Create a course: 

1. Go to http://ilrn.heinle.com/

2. Click the Login button.

3. Enter your username and password. Click Login.

4. Enter your book key in the field labeled Enter book key, located in the 
upper-right corner of your screen. You will be prompted to create a course. 
If you wish, you can now discard your book key; you will not need to use it 
again. 

5. Fill out the form and click Submit. (Don’t worry—you will be able to edit this 
information later if you need to.)

Note: Instructor book keys are 16-19 character codes that give you access to a book. 
You can request one from your Heinle sales representative or at http://hlc.quia.com/
books/bookstore.html. Select Adoptions/Trials to request a book key. 

Create a class: 

1. From the Classes tab, open the Class drop-down menu and select Create a 
new class. 

2. Fill out and submit the form. (If you wish, you can make changes later.)

3. Make sure sure to enter class times and locations. This will help students 
enroll in the appropriate section.

Note: The course code is in the box in the upper right of your screen. Your students 
will need this code to register for your course. The easiest way to tell your students 
how to sign up for your course is to distribute registration instructions. You can print 
these out to distribute in class, or copy and paste the instructions into a class-wide 
email.

Add Teaching Assistants
If you have teaching assistants for your classes, you can grant them access to the class 
or classes they will be monitoring. Assistants will only have access to the roster, re-
sults, assignments, and class information. Assistants will not have access to book and 
course level settings, customizations, or grading options. Your assistants do not need 
to enter book keys. They only need to create an iLrn: Heinle Learning Center account 
and provide you with their username. Then you can add them by following these steps:
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Add a teaching assistant:

1.	 Click the Classes tab and the Class Info sub-tab

2.	 Press Edit next to a class name.

3.	 Scroll down to the Assistants box and enter your assistant’s iLrn: Heinle 
Learning Center account username. If you have multiple assistants who will 
be accessing this class, enter the usernames separated by commas.

Student Registration
Now that you have created your course and classes, you can allow students to regis-
ter. You won’t need to type any student names, because students will add themselves 
to your course. If you have set up multiple classes (because you teach multiple sec-
tions), make sure that you have entered the location and time for each class; other-
wise students will not know which class to enroll themselves in. When you are ready 
for students to register, distribute the registration instructions. To find the registra-
tion instructions:

1. In the Instructor Workstation, you will see a list of all your courses. Click on 
a course name to drill in.

2. In the upper right corner of the screen, you will see a box with a Printable 
registration instructions link. Click on the link. 

3. Photocopy the instructions and hand them out to all of your students, or 
copy and paste all in the instructions into a class-wide email.

Customizing Your Book
You can customize your book by changing the tracking, feedback, and grading options 
for existing activities including:

Tracking: Credit/No credit, Timed and graded, Graded

Accents: Match accents, Don’t match accents

Feedback: No feedback; Score only; Score and summary; Score, summary and an-
swers
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Change the tracking, feedback, and grading options for all exer-
cises in the book at once:	

1. Select the Books tab.

2. Select the Options sub-tab.

3. To change the grading style, accents or feedback options, click the button for the 
desired option.

4. Select Save changes to confirm your selection or Cancel.

Change the tracking, feedback, and grading options for individual 
exercises:	

1. Choose the course that has the book you would like to customize. All classes in the 
course will see the customizations you make.

2. Select the Books tab.

3. Select the Customize sub-tab.

4. From the Section drop-down menu, choose the section of the book that contains 
that exercise you want to change.

5. Follow the instructions described below for each option.

1) Tracking

For each activity in the book, you can set how you want to track student results, or 
whether you want to track results at all. There are four tracking methods to choose 
from: credit/no-credit, practice, graded, and timed and graded. Game style activities, 
like matching and challenge board, can only be set to credit/no-credit or practice.

4	Practice—The activity is not tracked; student responses and scores are not 
recorded.

4	Credit/No credit—The activity is tracked and students receive full credit (in 
the form of a check mark) for submitting responses, regardless of their scores. 
Students who do not submit the activity receive no credit.

4	Graded—The activity is tracked and student responses are recorded. You can 
view students’ scores and responses in the Classes tab, Results sub-tab.

4	Graded & Timed—The activity is tracked and student responses are recorded. 
iLrn: Heinle Learning Center also records the amount of time students spend 
completing the activity in the gradebook. This is located under in the Classes 
tab, Results sub-tab. Select an activity to view the Elapsed time.
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2) Feedback

The feedback setting determines what students see when they submit their results.

4	No Feedback—Students see a message thanking them for completing the 
activity and informing them that their responses have been recorded. They do 
not see their scores or what the correct answers were.

4	Score Only—Students receive their scores when they complete the  
activity. They do not see what the correct answers were or which questions 
they missed.

4	Score and Summary—Students receive their scores and an answer summary 
after completing the activity. The answer summary includes the student’s 
responses but does not show the correct answers for questions that were an-
swered incorrectly.

4	Score, Summary, and Answers—Students receive their scores, an answer 
summary, and correct answers after completing the activity.The answer sum-
mary includes the student’s responses and correct answers for every question. 
This is the default setting for most activities.

3) Options

You may set other grading options as well. The options are:

4	Accents Must Match—In most world languages books, student responses are 
marked incorrect if they do not include the appropriate accents and diacritical 
marks. You may choose to grade more leniently by ignoring accents.

4	Case Sensitivity and Punctuation—iLrn: Heinle Learning Center usually 
ignores capitalization and punctuation (except in German books, which check 
capitalization). You may force capitalization to match by checking the box 
labeled Grading is case sensitive. You may force punctuation to match by un-
checking the box labeled Ignore punctuation. By default, the following punc-
tuation marks are ignored: ! “ ‘ , - . : ; ? — ¡ « » ¿ — ‘ ’ “ ” „ Spacing is always 
ignored.

4) Creating your own activities

Some books include a Supplement section. If your book includes a Supplement  
section, you may add to your book by creating your own activities using any of the 15 
templates. Your new activities are placed in your book’s Supplement section and are 
available to all of your classes. 
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Create new activities:

1. Go to the Books tab.

2. Select the Customize sub-tab.

3. Choose Supplement from the Section drop-down list and click Go.

4. Choose an activity type from the Create drop-down list and click Go. An  
activity editor will open in a new window. Follow the directions, and click  
on the Help links for more information.

5. When you finish creating your activity, it will be listed in the Supplement 
section, but it will not be available yet to students (in case you still need to 
make changes to it).

6. When you are ready to make your activity available to students, check the 
box in the Use in book column.

7. At any point, you may edit or copy your activity by clicking the Edit or Copy 
links. You may also change your activity’s tracking and feedback options.

8. If you would like to share your activity with other instructors who are using 
the same book, check the box in the Share column. 

Copy Activities from Other Instructors

If other instructors using iLrn: Heinle Learning Center have chosen to share their  
activities, you may copy them and then modify them for your own use. Select Copy 
from other instructors (supplements only section) and click Go. Check the boxes 
next to the activities and click Copy activities. To modify an activity, click Edit next to 
the activity.

Instructor View 

Instructor Dashboard

Manage your course -- assign, grade and assess student progress all from one screen. 

From the dashboard, Instructors can: 

4View alerts about what students have recently submitted

4View which students submitted exercises with low scores

4View which students submitted exercises late

4View which exercises require the instructor to grade

4Access action links to grade and view exercises
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Calendar

The new calendar feature within the dashboard allows instructors to assign activities, 
view submissions (on time, late and missing), obtain a mean score, and completion 
dates. For each activity assigned, the instructor can view and/or grade the exercise.

Assign Activities

You can assign activities directly from the Instructor Dashboard by clicking Assign 
Activities under the My Tools menu.

Assign activities at the class-level

1. From the Instructor Dashboard, click Assign Activities. You will be brought 
to the Assign sub-tab under the Classes tab.

2. Choose the book and chapter from which you want to assign activities using 
the Book and Section drop-down menus.

3. Select the activities you want to assign. To give all activities the same due 
date, go to the Actions… drop-down menu and select “Assign and set due 
date.” To give each activity a separate due date, click in the “Due date” 
field for each activity

Assign activities at the course-level

1. Go to the Books tab.

2. Click the Assign sub-tab.

3. Check the boxes next to the activities you want to assign. To give all activi-
ties the same due date, go to the Actions… drop-down menu and select 
“Assign and set due date.” To give each activity a separate due date, click 
in the “Due date” field for each activity.
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Administering Tests
You can now administer tests online using iLrn: Heinle Learning Center. You can set 
time limits so students have limited periods of access and grades go directly into the 
gradebook. To administer a test, follow these steps: 

1. Select the Books tab. 

2. Select the Customize sub-tab. 

3. In the Book drop-down menu, select Textbook Activities and click Go.

4. In the Section drop-down menu, select an exam and click Go.

5. Check the Use in book box.

6. Click on the exam title to preview it. 

7. To set time limits so students only have a limited amount of time to access 
the test, click the Set button in the Limit dates column.

8. Select your dates

Here are some tips to avoid cheating and make tests more secure:

4Change Feedback options for Exam to No Feedback or Score Only. You can 
change this back after tests are completed and students will then see feedbac

4Limit the number of attempts a student has on an Exam to 1

Student Results and Grading
You’ll find that many of the exercises in your iLrn: Heinle Learning Center book are 
completely computer graded. As soon as students complete an exercise, iLrn: Heinle 
Learning Center immediately corrects their work, reports a score, and stores their 
results. You don’t need to do anything, although you may review and adjust the com-
puter’s grading decisions if you wish.

Grading Status Indicators

Exercises in iLrn: Heinle Learning Center books fall into three categories:

4	Green exercises—(marked with a green dot) are completely computer graded 
and include multiple choice questions, true/false questions, and short-answer 
questions, where there are a limited number of student responses that one 
would consider “correct.” You do not need to grade these.
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4	Yellow exercises—(marked with a yellow dot) are also computer graded, but 
are somewhat open-ended, with the possibility that a student might type a cor-
rect response that the computer software doesn’t recognize. We recommend 
that you scan through students’ responses just to make sure that there aren’t 
any correct responses that the computer grading software overlooks.

4	Red exercises—(marked with a red dot) are too complicated for the computer 
software to attempt to grade. These are typically questions requiring para-
graph- or essay-length responses. You must always grade these questions. 

Grading from the Instructor Dashboard

You can set the My Alerts section in the Instructor Dashboard to tell you, at a glance, 
whether you need to review particular exercises. 

To see a summary of student results: 

1. Login to the Instructor Workstation.

2. Select a course.

3. Under the Dashboard tab, look for the My Alerts section and select any of 
the following:

4	What do I need to grade?—By selecting this box, the Dashboard will 
inform you of any yellow- or red-coded exercises that need manual 
grading.

4	What was submitted recently?— If you keep this box selected, you 
can get real-time information on recent student submissions by clicking 
the Refresh button

4	What was submitted late?—Keeping this box selected will tell you 
how many students submitted an activity late.

4	Who received a low score?—Keeping this box selected will tell you 
how many students received a score of 60% or below.
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Each alert contains hyperlinks that give you more information about each activ-
ity. Clicking on the bell next to the alert will either take you to your gradebook to 
view student results or straight to the grading overview to begin grading student 
responses immediately. Hovering your cursor over the word “students” will tell 
you which students submitted the activity, submitted it late, or received a low 
score. If you hover your cursor over the activity name, a menu pops up, giving you 
the choice to view the activity, grade it, Quick-Grade it, or view your gradebook.

Note: You can also view student results by drilling into the gradebook from the 
Classes tab.

To view student results for multiple activities at a glance:

1. Login to the Instructor Workstation.

2. Select a course.

3. Click the Results sub-tab under the Classes tab. 

4. To switch to a different class, make a selection from the Class menu.

5. To switch to a different section of the book, make a selection from the 
Section drop-down list.

6. You can toggle between the Student Activities Manual, Textbook Activi-
ties results or results for both by selecting from the Book drop-down 
menu. 

The Section Summary table shows you overall statistics, like mean, low, and high 
scores, for a particular class and a particular section of the book. You may wish 
to alter these scores by weighting the book’s exercises differently. To do so, click 
Adjust in the Section Summary table.

Below the Section Summary table are detailed results, by student, for each exer-
cise in the selected section of the book. From here you can do the following:

4View the percentage earned on a particular exercise, by student, or a 
check mark if an exercise is credit/no-credit.
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4Click the magnifying glass icon to view an exercise.

4Click the “A” icon to assign or unassign an activity. 

4Click the 100% Quick Grade button to assign full credit to students who have 
completed an exercise, regardless of their responses. 

4Click the pencil icon next to an exercise to grade it (and optionally, to leave 
feedback for students).

4View a particular student’s results on an exercise by clicking an underlined 
percentage score or checkmark.

Grading and Entering Feedback

There are two ways to grade an exercise:

4	By student—When you grade by student, you grade all of student A’s respons-
es, then all of student B’s responses, and so on. This is how traditional, paper-
based assignments are usually graded.

4	By question—When you grade by question, you grade every student’s response 
to question 1 at the same time. Then you move on to question 2, and so forth. 
In general, grading by question is much faster and lets you more easily compare 
students’ responses and assign more accurate grades.

To manually grade: 

1. Click the pencil icon that appears next to an exercise number. This will take 
you to the grading workbench.

2. To grade by question, click the pencil icon next to the questions that have 
red or yellow indicators.

3. To grade by student, scroll down to see a list of students, and click the pencil 
icon next to a student name. 
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Note: When grading, you may enter personalized feedback for your students. You can 
leave comments for a particular question or for an exercise as a whole in the fields 
labeled Comments. For voice-enabled activities,  you can record comments for the 
student to hear. When students login to iLrn: Heinle Learning Center to review their 
scores, they see or listen to your feedback. 

To use 100% quick grade: 

For a grading shortcut, you can click the 100% quick grade icon to give full credit 
to students who have completed a particular activity, regardless of their responses. 
If you prefer, you may change the 100% quick grade setting so that it only gives full 
credit for questions that have been answered, and gives no credit for unanswered 
questions.

1. Go to the Options tab.

2. Click Grading options.

To use Credit/No credit: 

Another timesaving grading option is to make exercises Credit/No credit. When an 
exercise is Credit/No credit, students receive full credit (in the form of a check 
mark) for submitting responses, regardless of their scores. Students who do not 
submit the exercise receive no credit. Credit/No credit exercises are always marked 
with a green indicator, meaning that no additional instructor review is required

Allow multiple attempts: 

You have the option of allowing students to do a particular exercise multiple times 
to practice and improve their performance. You can choose whether to use their first 
attempt, their last attempt, or their best attempt when calculating scores; you can 
also ignore all results after a certain number of attempts.

To define the number of attempts and choose which one to score:

1. Click on the Options tab.

2. Click the Grading options button.

3. Choose whether to use students’ first, last, or best attempt in scoring.

4. If you want to ignore all results after a certain number of attempts, check 
the box and select a value from the drop-down list. For example, if you 
select “3rd,” the grading software will ignore all results after the third at-
tempt. 
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Add a column to the gradebook
Instructors can add a column to the gradebook to track in-class projects, participation 
or attendance. 

1. From the Instructor Dashboard, click on the Classes tab.

2. In the View drop-down menu, select which book you want to add a column 
to or if you want to add a column to the entire gradebook. 

3. Click on the   sign to the far right of the gradebook columns. 

4. Give the column a title and start adding scores.

View diagnostics test results and study plan
Now it is easy to see how your students are doing on their diagnostics tests and view 
their personalized study plans. 

1. From the Instructor Dashboard, click on the Classes tab.

2. To the right in the My Tools box, click View diagnostics results.

3. Here you can see each of the students scores. Click on any name.

4. Click on the book icon to see the personalized study plan. 
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Instructor Resources
Resources available only to instructors can be found under the Files tab in the Instructor Work-
station. The digital resources Heinle provides will vary, but Powerpoint files, Instructor Manuals, 
sample tests, and audio files are among the types of materials that may be included. Instructors 
can also add their own files. To add a file to your account, click Upload and then select the file 
from your local drive. The file will be uploaded to the current folder displayed below. To create 
a new folder, click New folder. To move or delete files and folders, first check the boxes next to 
them, and then click the desired action button.

Create an announcement board:  

The announcement board enables you to communicate with all students enrolled in  your 
course. Your students conveniently access the announcements board  by clicking Announcement 
Board in the top navigation bar of their course. 

	 1. Login to the Instructor Workstation.

2. Select a course.

3. Click the Announcements tab.

4. Type your announcements.

Student View
As an instructor, you are also provided access to the complete student view. This will help you 
better understand what your students’ are experiencing.

Add yourself to the class roster: 

The first step to accessing the student view is to add yourself to the class roster. 

1. Click the Classes tab.

3. Click the Results sub-tab.

3. Select a class from the Class drop-down menu and click go.

4.  To the right in the My Tools box, click Submit activities as a student link. 

The student view will be displayed (see image below), and the next time you open your grade-
book or roster for the class, your name and results will be listed. 

Access the Student Workstation:
Once you have added yourself to the roster, you can access the Student Workstation  anytime by 
clicking the Student Workstation button in the top right corner of the Instructor Workstation.

In this view, students will see the books available for your course including the Workbook/Lab 
Manual and the Textbook Activities. They can choose one of the five tabs:
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1) Open book

This tab brings students to the Welcome page iLrn: Heinle Learning Center, where 

they have access to all the resources for the course. 

Students have access to these tabs:

4eBook—This page-for-page reproduction of the printed book features embed-
ded audio, video, and note-taking and text highlighting capabilities. NEW 
Smart Icons in the eBook tell students whether a particular activity has been 
assigned, completed, or graded. The page view can be magnified and the con-
tent searched via the index, table of contents, or search functions.

 4Textbook Activities—Students can select a chapter and view all of the exer-
cises for each chapter. Links to the exercises are available here, the student 
calendar and directly from the eBook.

4	Student Activities Manual—An online version of the Student Activities Manual 
with audio allows students to get immediate feedback on their work and fea-
tures a wide variety of high-interest exercises, games, and assessment tools; 
floating and stationary accent bars for a specific language; and self-scoring 
tools that allow students to track their own progress.

  4Video Library—Students can access accompanying video segments. You can 
can also turn closed captioning on and off as an aid to understanding.Video 
segments may be accompanied by pre- and post-viewing exercises.

 4Enrichment—Depending on the title, enrichment activities might include any 
or all of the following additional activities: vocabulary flashcards; grammar 
and pronunciation tutorials; additional self-graded quizzing; and access to 
Heinle iRadio’s MP3-ready cultural exploration activities.

 4Diagnostics— Students may take an online diagnostic Pre-Test before or after 
working through a text chapter to get an initial assessment of what they know 
and what they still need to master. Student results are graded automatically 
and displayed according to learning outcomes. A Personalized Study Plan, 
based on the automatically graded Pre- or Post-Test, directs students to addi-
tional study aids. 
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Students have access to these tools: 

At the top of the Welcome Screen, students can also access the following resources:

4Calendar—In this NEW feature, students can see all their assignments due that 
week, and any announcements from the instructor. (Announcements flow di-
rectly from the Instructor Dashboard.)

4VoiceBoard—This is where students complete paired and group oral activities 
from the textbook.

4	Personal Tutor—An online tutor with teaching expertise in the target language

4	WIMBA ™ Classroom —If you are leading a distance-learning or hybrid course 
using WIMBA ™ Classroom, your students will access the Classroom here. You 
will first need to enable WIMBA ™ Classroom for your students to join. See be-
low for more information regarding WIMBA ™ Classroom 

4	Help —A brief manual for navigating the Student Workstation.

2) Class details

Students can see course information (title and section name, instructor email, course 
code and duration of course) as well as book information (book title, publisher).

3) My results

Students see information about their performance, with a clear presentation of several 
categories viewable by book and chapter. The Book drop-down menu allows students 
to toggle between viewing their results for Student Activities Manual and Textbook 
activities 

4) Announcements

Students can consult this to see if the instructor has created any announcements. 

5) Options

Students can drop a course, transfer to a different class, or transfer to a different 
course.
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Voice-enabled Activities
Students can complete voice-enabled activities alone or with a partner. NEW to iLrn, 
you can also assign group activities, which students can submit in groups of up to five. 
Students can talk to a partner and text chat via the voicebaoard to work together on 
the activity. Then they record a conversation that you, the instructor, will grade.

Tips for Instructors

As an instructor, you can record audio comments in response to your students’ voice-
enabled exercises. When you want to grade a voice activity, click on the grade icon in 
the Results tab. You will find a play button to listen to the students’ recording. You 
will also see a record button where you can record your feedback. The recordings for 
paired and group activities can be found in all participants’ results, and you can leave 
individual feedback for each student.

WIMBA Classroom
WIMBA is a completely online, synchronous classroom. With Wimba Classroom, you 
will be able to conduct class, show presentations, and interact with your students in a 
live online session.

System Requirements

Make sure your computer meets the following requirements to run the WIMBA class-
room:

• Windows 7, Vista, or XP; Mac OSX 10.4+

• 256 MB RAM

• IE 7.0+, Safari 3.0+, Firefox 3.0+  (Browser must be Java and JavaScript enabled)

• Internet access at 56k or above 

• Java 1.6r7 or higher

You will also need a headset and a microphone.  It is recommended that you use an 
external headset that you plug into your computer.

WIMBA Classroom is available as an optional upgrade to iLrn: Heinle Learning Center 
and is accessible directly from the Instructor Workstation.
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Activate your WIMBA Classroom 

1. Login to the Instructor Workstation.

3. Click the Options tab.

3. Click the Turn on Wimba button at the bottom of the page,

4. You will be asked to confirm the activation of your classroom. Click Confirm 
to turn on WIMBA.

Once your WIMBA account is activated, you will be able to access your classroom di-
rectly from the Instructor Dashboard.

Navigate your WIMBA Classroom

When you are ready to begin your class, click the “Launch WIMBA Classroom” link from 
the Instructor Dashboard. Each of your classes (sections) has its own classroom; every 
time you launch WIMBA you’ll be prompted to choose which classroom to enter. After 
you choose your class, your classroom will open. 

4  Content Frame—The main screen of the WIMBA Classroom is the Content Frame 
or Whiteboard, where you can show any presentation materials (PowerPoint, im-
ages, eBook pages, etc.).

4	Text Chat Frame—Use this feature to send chat messages to all students here, 
or pick a student from the drop-down menu to send a private message.

    To send a public message (viewable by everyone in the room), select Main Room 
from the drop-down menu in the bottom left corner, type your message, and 
press Enter. To send a private message, select a person’s name from the drop-
down menu, type your message, and press Enter.
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     NOTE: Your students can also send messages to one another unless you disable 
the Chat feature. To disable, to go the Actions menu under the Participant 
list, and click Enable/Disable Chat.

  4Participant Frame—The box labeled People lists everyone in the room, 
including you and your students. Your name will appear at the top. The Partici-
pant Frame contains several features for measuring student feedback

  4Yes/No Buttons—If you ask your students a yes/no question, they can 
answer instantly by click the green check for Yes or the red X for No.

  4Hand Raise—A number will appear next to the name of a student who 
has raised his/her hand. This number indicates the order in which your 
students raised their hands.

  4Status Indicator (Emoticons)—An emoticon will appear next to a stu-
dent’s name if he/she selects one from the menu at the bottom of the 
Participant Area.

  4Plus or minus sign—indicate whether a student has certain privileges 
in the classroom. These privileges include: speaking, video broadcast-
ing, chat, and presenter privileges. These privileges can be enabled or 
disabled from the Options menu at the bottom of the Participant Area.

  4Media Bar—The Media Bar appears above the Text Chat Frame. The three bars 
to the left of the Talk button will indicate the strength of your internet con-
nection.  To the right you may adjust your volume levels, and audio and video 
options. You can control audio and video from the Media Bar. Press the Talk 
button to speak, and the camera button to begin broadcasting video. 

4  Presenter’s Console—You control your entire presentation from the Present-
er’s Console, including displaying and sharing content, starting an archive, and 
managing breakout rooms.  

Conduct Online Classes with WIMBA

You will control your entire presentation from the Presenter’s Console. There are two 
ways to display content in your classroom: using the Slide List, or sharing materials 
“on-the-fly.”

1) Use the Slide List

The Slide List is a built-in slideshow presentation that you prepare in advance of your 
class. It can contain PowerPoints, images, websites, PDFs, and other documents. Your 
Instructor Dashboard in iLrn: Heinle Learning Center will contain a link to add con-
tent to WIMBA classroom after you have activated your WIMBA account.
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To locate the material you have uploaded, select the appropriate folder from the 
drop-down menu in the Presenter’s Console and click Go. You can select a folder from 
a different classroom by clicking More Folders… at the bottom of the list. 

Each piece of content from your presentation will appear in the Presenter’s Console. 
Click each piece to show it in the Content Frame.

2) Share “On-the-Fly” Content

You can also share content “on-the-fly,” either to supplement your prepared lesson or 
as your main presentation.

4  Share a PowerPoint presentation—click the Upload PowerPoint button 
and browse to find your presentation. Select the eBoard as your display tar-
get. Click the Import button to create a new Content Folder in the Presenter’s 
Console.

4	Share a web page—Click the Web button (located on the Content tab on the 
Presenter’s Console). Type the URL of the web page you would like to show, and 
click Show Web Page. The page will appear in a new window.

 4	Share an image—Click the eBoard button (located on the Content tab on the 
Presenter’s Console). Click the Import button and browse for the image you 
want to show. You can then use other eBoard tools (pointers, highlighter, lines, 
circles, text) to annotate your image.

4	Share an application —Click the Share button (located in the Content tab of 
the Presenter’s Console). Use this to share any application such as Microsoft 
Word or Internet Explorer with your students. The AppShare Status window 
opens, where you can choose where to display the application. Click the orange 
button to begin sharing. To end sharing, locate the original AppShare Status 
window and click the End Sharing button.

3) Use Breakout Rooms

You can divide your students into small “breakout” groups in order to do pair/group 
activities in class. Before splitting up your class, be sure to enable speaking and/or 
chat privileges for your students using the controls on the Participant Area window. 

1. Click the Breakout Rooms tab in the Presenter’s Console. 

2. To move students manually to breakout rooms, click and drag each student’s 
name into the desired room.

3. To move students automaically and randomly, click the Automatic link. Use 
the drop-down menu to distribute users to your desired number of rooms.

4. When you are ready for all users to return to the Main Room, click Automatic 
and select To Main Room.

Note: To visit the breakout rooms, select the Manual option and drag and drop yourself 
into the desired room.
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Archive your Classes

You can save your classes for students to view later as a study aid. An archived class 
captures and synchronizes:all audio and/or video; public (but not private) text chat 
contents; eBoard  annotations and content; application sharing and polling. To archive 
your class: 

1. Click the black Recording button at the top of the Presenter’s Console

2. Click OK to confirm that you would like to begin recording

3. The Recording button will turn red. Click this button to stop archiving.

Using Personal Tutor 

What is Personal Tutor?
4Personal Tutor provides tutors exclusively from among experienced and qualified 
instructors.  Tutors have achieved high grades in their degrees (many have a Master’s 
degree and higher) and have real classroom teaching experience.  All of Personal Tu-
tor’s tutors are located in Tampa, FL, and are monitored on-site by a director, who 
also holds a Ph.D.

How does Personal Tutor work?
4Personal Tutor provides whiteboard technology for synchronous tutoring (Q&A ses-
sions) that also includes video and audio capabilities (for those students who want 
these extra features).  

How many hours of tutoring do students get on Personal Tutor?
4Personal Tutor provides students with  5 hours of tutoring time. 

4Students have 3-semesters to use the 5 hours of tutoring

What if a student needs additional tutoring hours on Personal  
Tutor? 
 
4Students have the option of purchasing additional tutoring directly from Personal 
Tutor if their hours/paper submissions are used up before the end of a semester.  The 
cost is significantly less at $29.99 for an entire month of tutoring versus paying $35 
per hour from other services. 

When will tutoring be available? 
4Tutors are available for online tutoring seven days a week, and offline questions 
and papers can be submitted at any time, 24 hours a day.  Online tutoring is available 
for languages at the times below. Responses to offline questions can take 24 to 48 
hours to be returned, however, they are usually returned within one day.
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Spanish French Italian German
MONDAY 9AM-1PM  

9PM-12AM 
TUESDAY 9AM-1PM 4-8PM 8PM-Midnight
WEDNESDAY 9AM-1PM  

9PM-12AM 
6PM-10PM

THURSDAY 9AM-1PM 4-8PM 8PM-12PM
FRIDAY 9AM-1PM  

5PM-9PM 
4-8PM

SATURDAY 12PM-4PM 4-8PM
SUNDAY 3PM-7PM 7PM-11PM

Frequently Asked Questions

What is the difference between a course and a class?
A course in iLrn: Heinle Learning Center is just like a course in your school’s course 
catalog, like French 101. Within each course, you’ll have one or more classes. Classes 
are analogous to sections in a university course: they are groupings of students within 
a course. Thus, if you teach five sections of French 101, you would create five classes 
within your online course.

How do I drop a student who doesn’t belong in my class?
When you drop a student, all records of his or her scores and responses are removed. 
To drop a student:

1. Login to the Instructor Workstation.

2. Select a course and class.

3. Click Roster under the Classes tab.

4. Click Drop to the far right of the student’s name.

How do I transfer a student to a different class within my course?
To transfer a student to a different class:

1. Navigate to the student roster (Classes tab, Roster sub-tab).

2. In the Transfer column to the right of the student’s name, select the class 
you want to transfer the student to.

3. Click Update when you are finished.

To transfer a student to an entirely different course, you should drop the student and 
give the student the course code and registration instructions for the new course.  
Students can switch courses by:
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1. Logging into the Student Workstation.

2. Clicking the My Books tab and selecting the book that will be used in the 
new course.

3. Clicking Book Options, clicking Change course/instructor, and entering the 
new course code.

How do I start a new semester with a new set of students?
Just follow these steps:

1. Login to the Instructor Workstation.

2. Select the course that has ended.

3. Select Start new term and fill out the form.

4	If newer editions of your book are available, you will have the option of 
choosing a newer edition of the book. If you have made any customiza-
tions to your book that you want to keep, besides creating new activi-
ties, you should choose the edition that you are currently using. Any new 
activities you created in the Supplement section will be saved regardless 
of which edition you select.

4. Click Submit when you are finished.

Once you have created your new course, you can create classes by selecting Create a 
new class from the Instructor Workstation home page (the page you see immediately 
after logging in). You may create as many classes as you want.

Do I need a new book key to start a new course for a new  
semester?
For most books, you do not need a new book key to start a new term (as long as you 
will be using the same book). However, certain books do require new book keys each 
semester. If you are using a book that requires a new book key each semester, you will 
be prompted to enter the new key.

What do students do when their books expire?
Student book keys generally provide access to a book for 12 to 18 months. When a 
student’s book expires, the student can extend the book for an additional 12 to 18 
months by following these steps:

1. Login to the Student Workstation.

2. Go to the My Books tab.

3. Click on the Book options button.

4. Click on the Extend link that appears next to the book duration.

5. Fill out the order form and click Submit.
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Contacting Technical Support
4	Visit http://books.quia.com/support

4	View FAQs at http://books.quia.com/help/books/faq.html for immediate 
answers to common problems.

4	Send an email to bookhelp@quia.com

4	Call Toll-free 1-877-282-4400 Ext: 2


